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1  introduction 

This is the last version  of the manual for the users of the BIOTOOL. The BIOTOOL is a software package for the evaluation of the thermal performance of pre-engineered buildings.

Two types of prefabricated buildings are defined within this software: light steel modular buildings (based on CORUS technology) and concrete heavy cellular buildings (based on PUJOL technology). In both cases, five pre-defined 3D typologies of dwellings are provided to the users so that they can easily create the thermal model. 

This building thermal performance package is an ASP model for the Architecture, Engineering and (AEC) sector. Two numerical codes related with thermal building simulation are coupled, adapted and simplified in order to use them like remote simulating applications.

1.1 Terminology

In the BIOTOOL the following terms are used and defined as follows:

· Zone
All zones (rooms) of the storey that have the same thermal properties 

· Wall
All structural divisions between zones or between a zone and the outside. The term includes façades, internal walls, floors and roofs.
ACH
Air Change Rate = number of times the air in the whole volume of a zone is refreshed per hour. [l/h]

1.2 Overview

The process of working with the BIOTOOL is as follows:

· The user chooses a typology from the data base of the tool

· The user defines for this typology: 

· Material of the structure: steel or concrete

· Climatic data (from the 15 cities available in the database)

· A building with all the material per default applied appears on the screen

· The user can run the simulation or change one or more of the following properties:

· Materials (walls, floors, windows, roofs)

· Orientation

· Settings (heating & cooling strategy, occupancy type etc)

· Airflow / ventilation values

1.3 Results of thermal performance 

The following results can be obtained with the BIOTOOL: 

· Temperature and air velocity distribution 

· Vector velocity distribution

- 
Comfort indexes distribution: percentage of person dissatisfied (TPD), Predicted mean vote  (PMV)

· Heating & Cooling Loads 
1.4 ASP Service

The BIOTOOL is an ASP (Application Service Provider) model. That means the user of the BIOTOOL does not need to have the real calculation software installed in their PC; the core calculation modules are hanged up in a remote server. 

The user only needs a part of the software to: 

· Introduce the thermal problem, 

· Write the problem in a data format required by the thermal software 

· View the results.

· Once the thermal problem (=building with conditions) is introduced, the data file can be written and sent to the server

· Once the server has calculated the results, these will be sent to the user again.

2 Structure / Overview

The process of working with the BIOTOOL is as follows:

· The user chooses a typology from the data base of the tool

· The user defines for this typology: 

· Material of the structure: steel or concrete

· Climatic data (from the 15 cities available in the database)

· A building with all the materials per default applied appears on the screen.

· The user can run the simulation or change one or more of the following properties:

· Materials (walls, floors, windows, roofs)

· Orientation

· Settings (heating & cooling strategy, occupancy type etc)

· Airflow / ventilation values

3 Process step by step

3.1 STEP 1: Choose typology

The user can choose a typology from the database of the tool.
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3.1.1 Predefined typologies

The BIOTOOL offers five predefined typologies. These typologies define the layout of the floor plans so that the user only needs to define the number of floors.

An example of the available typologies is given in the figure below:
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	Low rise suburban
	Access balcony
	Row house


3.2 STEP 2: Define number of floors
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In this option the user must select the number of floors of the building 

3.3 STEP 3: Define material type: 

Steel (Light - LT) or concrete (Heavy - HV)

3.3.1 Materials 

[image: image88.wmf]The BIOTOOL offers two wall types (walls include all elements that are not windows) and several window types. 

The main difference between wall types remains in the material  (steel or concrete)

3.4 STEP 4: Choose a climate data file

It is possible to choose fifteen climatic weather files from the following locations:
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	SPAIN
	U.K.
	DENMARK
	GREECE

	Barcelona
	London
	Copenhagen
	Athens

	Madrid
	Aberdeen
	Odense
	Thessaloniki

	Sevilla
	Glasgow
	Aalborg
	Chania

	La Coruna
	Plymouth
	Aarhus
	


3.5 STEP 4: Save project

After choosing all these parameters, a building appears on the screen with the characteristics you have chosen or defined.  You can save this project through the “save as” option and entering a name of your choice. The extension .gid will be automatically assigned 

3.5.1 Building with all default assigned materials

For this building the following materials and conditions have already been defined, according to your choice of material (steel or concrete) and your choice of location:

· Wall materials 
(depending on location and chosen material)

· Window materials
(depending on location)

· Occupancy 
(residential)

· Heating schedule
(set point 20ºC, 24 hours per day, during winter period)

· Cooling schedule
(set point 25ºC, 24 hours per day, during summer period)

· Summer / winter period:
(depending on location)

· Orientation
(mainly living room south)

· Infiltration rate
(depending on location)

· Ventilation
(none)
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	Example: Building materials for northern countries
	Building materials for southern countries


This means that for building situated in northern countries (England and Denmark) materials with lower U-values are chosen and a higher infiltration rate is applied that for locations in southern countries (Spain and Greece).

The exact default materials and settings applied can be found in part III, Chapter 7: Default values. How to change these properties is further explained in the following Chapter.
3.6 Step 5: Thermal performance simulation 

[image: image92.wmf] 

Generate the output data file for Thermal computation, and calculate.

3.6.1 View the thermal results
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The last step is to visualize results of the thermal simulation. After clicking the step “view 

Results” the following window will appear:

When selecting “file” you can browse for the results, which can be found within the folder of your project (the folder with the name you have given when saving the project):

1. [image: image94.wmf] 

Stedi_month.out
= 
monthly heating and cooling loads per m2 the whole building [kWh/(m2*month)]. See figure above



2. [image: image95.wmf] 

Stedi_day_qcool.out 
=  
daily cooling loads per m2 for each zone [kWh/(m2*day)]. See figure.

3. Stedi_day_qheat.out
= 
daily heating loads per m2 for each zone [kWh/(m2*day)]. See figure above.
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Stedi_day_temp.out
= 
average daily temperatures 
[ºC]. See figure

3.7 Step 6: Modify the assigned properties 
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Step 7 and 8 of the wizard can be used to change properties of the building

3.7.1 Changing Wall materials

The user can change any of the wall materials by clicking on step 7. The following “materials and properties” window will appear:
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The steps to be followed are: 

1. Select the material you want to assign to the geometry by picking the right box in the materials and properties window (see figure left).

2. Pick the element(s) in the drawing you want to work with (you can select all the elements that you want to assign the same material too).

3. Press the finish button in the materials and properties window.

The wall selection window will appear with all options (see figure right)

1. Choose the wall type you want to assign. By doing this the user has to take the function of the wall into account (see table)

The name of the walls is composed as follows: 

XX_YY_00_S/M/L

XX
refers to the function of the wall

YY
refer to the main material of the wall (HV = Heavy = concrete - LT = Light = steel)

S/M/L 
refers to the amount of insulation used for the same  (Small / Medium / Large)

For exterior façades 
( choose a wall starting with:
WE

For walls between dwellings (party walls)
(     
“
“
WP

For internal walls
(
“
“
WI

For the ground floor
(
“
“
FG

For ceilings / floors between zones
(
“
“
CE

For roofs
(
“
“
RO

For doors
( 
“
“
DOOR

Further information on wall types can be found in part 3.

	


1. Click OK ( The material will be assigned

2. Repeat step 1 to 5 for all elements until there are no elements left that do not have a material assigned.

Comments:

When selecting roofs, floors and ceilings, it can be helpful to use the “trackball” or “left” view of the geometry to see clearer which element you are selecting.

Trackball, Top view, Bottom view, Left view, Right view, Front view, Back view
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	With the trackball option the model can be turned around and viewed from any possible angle
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	By using these options, the direction from which the model is shown changes. There are six options: Top, Bottom, Left, Right, Front and Back view, from which the user can choose.


It is possible to select all elements in the right layer at the same time by selecting a rectangle around the building. After assigning the same material to all you can change the walls you might want to change.

3.7.2 Changing Window materials

Windows include closed exterior windows, opened exterior windows, and exterior opened or glass doors and other external openings. This means that if you want to change any of these elements, you have to choose the window box in the materials and properties window (see figure). 

[image: image12.wmf] 


The process is the same as the process of changing wall materials, only instead of the wall materials window, the window material window will appear:

- For all openings or opened windows choose the first option: OPEN. NO GLASS

- In this case you can define an air velocity for this window and define if this is inflow or outflow. (See figure) 

The window types are further explained in the annex

3.7.3 Change thermal zone properties

These properties include:

· Occupancy gains

· Heating and Cooling strategies

· Infiltration type 

[image: image13.wmf] 


Working method:

1. Press step 7 in the wizard

2. Select “zone properties”, the following window appears:

3. In the first variable, you can choose the occupancy type of the zone

4. In the third variables you can enter new values for heating and cooling strategies

5. In the last variable you can change the infiltration rate of the zone.

3.7.4 Changing the global settings

These settings include:

· Weather file 

· Start and stop time calculation

· Time step calculation

· Heating off period and cooling on period 

All times and periods should be introduced in hours of the year. In the table below some useful hours are reproduced.
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3.7.5 Natural Ventilation

When opening the window-material option, it is possible to assign “opened window” and define an airflow, which means air from outside can enter the building. Also, for all openings between zones, and airflow can be defined. When defining these values, the user has to take into account that the amount of air entering a zone is equal to the amount of air leaving the zone. To check if this is the case, the user might select the step 9 “mass imbalance”.

	[image: image100.wmf] 


	


When selecting the step 9, the next window will be opened. The mass Imbalance of each room must be equal to zero (see figure at the left); if this it not the case the window will show a red remark in the room with an error (see figure at the right).
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To solve the mass imbalance it is necessary to select “more” in the window and modify the flow rate of the mechanical devices or the opened windows. 
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To modify a flow rate the user picks a window or mechanical devices in the room that has a mass imbalance, and the next window will be opened:
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That solves the mass imbalance in the room. Selecting a new flow, the software will calculate the mass imbalance and will check if it is equal to zero. In a next version of the BIOTOOL this feature might be changed. 

3.8 Step 6: To perform the CFD simulation

Load the Favent problem type. From the newly created Favent menu appearing in the menu bar, activate the Wizard to display a list of the steps to follow for performing a CFD simulation. 
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Theses options are only shortcuts to functions already existing in GiD. They will now be described one by one.

3.8.1 Open project 
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The first option is not to be used if you are working on a new geometry. Remember that the dimensions must be given in meters. Project must be saved in the Examples directory of GiD. Next figure shows the directories containing some examples.

3.8.2 Problem data

The second step consists in editing the physical as well as the numerical data of the problem. If you click on the icon, the “Problem data” window pops up. It consists of three sections which names explicitly describe their contents.
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3.8.3 Physical data


Time behavior 

The time behavior option offers three possibilities:
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The transient option is to be used when a fully transient simulation is wanted. You therefore have to set the initial and final time of your simulation, as well as the time step size. If you do not know the time step size, the program will automatically select it, according to the time accuracy required (set in the Numerical data section).  The stationary option cancels the time derivative terms of the governing equations. Finally, the Transient-to-Stationary option can be useful when a steady state cannot be reached using the Stationary option. In this case, the programs performs a time marching strategy, by solving each physical problem only once at each time step. The time step size is chosen internally depending on the Time accuracy option used in the Numerical data section. According to the selected option, the algorithm is the following

[image: image104.wmf] 


Thermal behavior

The thermal behavior determines if you want to solve the heat equation, and, if this is the case, if they should be coupled to the Navier-Stokes equations through the Boussinesq approximation. 
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State of the flow

These options determine the state of the flow, i.e. the regime. The three possibilities are:
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Laminar flow solves the Navier-Stokes and heat equations in the laminar regime (t=0 and kt=0). Turbulent flow with low Re solves the RANS and heat equations together with a turbulence model, and integrating the flow equations up to the wall. This option must only be used if you can ensure you have sufficiently fine grid near the wall (which can be achieved only for relatively low Reynolds number flow, say Re of the order of 103). Finally, last option solves for the RANS and heat equations using the wall functions on the wall boundaries. If you chose this option, you must provide the distance to the wall. For the flows of interest, the distance to the wall is of the order of centimeters.

Gravity axis

Finally you must choose the gravity axis. If you choose not to consider gravity effects, the Coupled thermal flow option does no longer make sense, and the program will internally deactivate it. 

3.8.4 Numerical data


This section sets the numerical data. The options are:
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Convergence accuracy

This option sets the level of accuracy wanted by the user.  In numerical terms, the program stops when the L2 residual norm of the velocity reaches a stopping value. A low convergence accuracy means a high stopping value of the residual.

Time accuracy

When transient-to-stationary or transient option is activated, and when no time step is prescribed by the user, this option sets the safety factor to be multiplied by the critical time step calculated by Favent CFD. A High level will have a smaller time step than a Medium level…

Maximum number of iterations

This number is the maximum number of total iteration to be run by Favent CFD, including time loop and coupling loop iterations.

Solver type

This option sets the type of solver. In this version, only a direct solver is used to invert the algebraic systems resulting from the finite element discretization of the flow equations.

Post process steps

Put an integer N. The flow variables will be post-processed each N time step. For a stationary simulation, the results will be dumped only at the end of the process.
4.2.3
Advanced options


Discontinuity capturing 

It should be put to On to avoid possible local oscillations (leading to unphysical results) of the solution, and sometimes to enable convergence. However it may result over-diffusive for some low Reynolds flow problems, and therefore should be put to off for such flows.

Witness points

This option is useful to follow the time evolution of the flow variables at some points of the domain. You have to enter here up to five coordinates as follows:

x1,y1,z1, x2,y2,z2, x3,y3,z3, x4,y4,z4, x5,y5,z5
During the calculation process, you will be able to follow the evolution of the velocity and temperature at the five points Pi of coordinates (xi,yi,zi) with i=1,2,3,4,5.

3.8.5 Boundary conditions

The boundary conditions should be imposed on the whole outer boundary of the computational domain. There names end with suffix 2D for two-dimensional problems and with suffix 3D for three-dimensional problems. In the first case, they must be imposed on lines. In the second case they must be imposed on surfaces. The conditions are Wind, Window, Mechanical device, Wall and Symmetry. They are shown in the following figure.
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In order to impose a boundary condition:

· Select its name in the list menu.

· Select the desired options and enter the corresponding data.

· Press the Assign button.

· Pick the line (or surface in 3D) to which you apply the condition.

· You can visualize the condition you have assigned by choosing the option Draw -> Colors.

Wind 2D

For this condition you have to prescribe the value of the wind velocity (in m/s) as well as the temperature of the wind (in Celsius degrees) if the heat equation is solved.

Window 2D 

For this condition you have to decide if the window is open or close. In the first case, zero traction and zero heat flux are imposed. In the second case, the window is like a wall, and if the heat equation is solved you have to prescribe a condition for the temperature.

Mechanical device 2D
For these conditions you have to set if the line (or surface) is an inflow and the type of prescription for the heat equation. If this is an inflow, the program automatically fixes the velocity normal to the line (or the surface) and points it to the interior of the domain, with the prescribed module.  If this is an outflow, the velocity points to the outside of the domain.

Wall 2D

For walls, you only have to set the prescription for the heat equation. The type of condition applied to the Navier-Stokes (or RANS) equations will depend on whether you integrate up to the wall or use the wall function approach.

Symmetry 2D

This condition should be used on lines (or surface) on which the flow cannot escape. This corresponds to the following physical conditions: 


[image: image23.wmf]s

n

××=×=

¶

=

¶

¶

=

¶

0, 0

0

0

t

T

ngun

n

n


Important to remember: each time you change the boundary conditions you have to re-mesh the computational domain before performing the simulation.

3.8.6 Generate Mesh

When you press this button, GiD asks for the element size. If you have never meshed this geometry, it proposes automatically a size. With this automatic size you usually obtain a coarse mesh.  

You can assign sizes on entities using the option Meshing -> Assign. Unstruct. Sizes for example to refine the mesh on the walls. In the following figure, the lines of the cow were assigned an element size of 0.1 while the domain was meshed with an element size of 11. The transient from 0.1 to 11 is controlled by the option Utilities -> Preferences -> Meshing.
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3.8.7 Save the project

If this is a new project, GiD will ask you to give it a name.

3.8.8 Calculate

This option launches the CFD code. While FaventCFD is running you still have many things to do. 

· Put on the table if it’s lunch time…

· Check the data you have entered by selecting the option Favent -> Log file. The content of this window is sufficiently explicit for not to be explained. An example will be shown in Examples section.

· Follow the convergence of the algorithm by selecting the option Favent -> Graphs -> Convergence from the menu.

· If you have selected witness points, you can follow the evolution of their velocities (or temperatures) by selecting the option Favent -> Graphs -> Witness velocity (or Witness temperature) from the menu.

· Check the distribution of y+ on the walls by selecting the option Favent -> Graphs -> Wall law from the menu.

Anyway, GiD informs you when the simulation is finished.
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3.8.9 Post-process

By selecting this option, you go to the post-process module of GiD. Note that if you are running a transient simulation, results can be visualized as they are being dumped along the time advance.  Activate the window of results by selecting the option Windows -> View results from the menu.
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The variables that can be visualized in the post-process are the velocity, pressure, streamlines (in 2D), and temperature when the heat equation is solved. To change the style of visualization select the option Windows -> View style from the menu.

4 Background information on technical and physical issues

4.1 Wall materials

The name of the walls is composed as follows: 

XX_YY_00_S/M/L

XX
refers to the function of the wall

YY
refer to the main material of the wall (HV = Heavy = concrete - LT = Light = steel)

S/M/L 
refers to the amount of insulation used for the same  (Small / Medium / Large)

For exterior façades 
( choose a wall starting with:
WE

For walls between dwellings (party walls)
(     
“
“
WP

For internal walls
(
“
“
WI

For the ground floor
(
“
“
FG

For ceilings / floors between zones
(
“
“
CE

For roofs
(
“
“
RO

For doors
( 
“
“
DOOR

Further information on wall types can be found in part 3.

4.1.1 Parameters Wall Dialog Box

In the wall-specification dialog box, a short name and a material description of each wall are given. The short name refers to the category and type; the description gives the exact material information, describing the composition from inside to outside.  

Table 4‑1:  Overview wall types

WE_LT_01_S: 
light façade - U=0.30 W/m2K - double plasterboard - mineral wool 150 mm - metal cladding 

WE_LT_01_M: 
light façade - U=0.20 W/m2K - double plasterboard - mineral wool 230 mm - metal cladding 

WE_LT_01_L: 
light façade - U=0.16 W/m2K - double plasterboard - mineral wool 270 mm - metal cladding

WE_LT_02_S: 
light façade - U=0.30 W/m2K - single plasterboard - mineral wool 150 mm - ceramic cladding

WE_LT_02_M: 
light façade - U=0.20 W/m2K - single plasterboard - mineral wool 230 mm - ceramic cladding

WE_LT_02_L: 
light façade - U=0.16 W/m2K - single plasterboard - mineral wool 270 mm - ceramic cladding

WE_LT_03_S: 
light façade - U=0.28 W/m2K - single plasterboard - mineral wool 150 mm - wood cladding

WE_LT_03_M: 
light façade - U=0.19 W/m2K - single plasterboard - mineral wool 230 mm - wood cladding

WE_LT_03_L: 
light façade - U=0.16 W/m2K - single plasterboard - mineral wool 270 mm - wood cladding

WE_LT_04_S: 
light façade - U=0.58 W/m2K - steel sandwich panel 50 mm

WE_LT_04_M: 
light façade - U=0.43 W/m2K - steel sandwich panel 70 mm

WE_LT_04_L: 
light façade - U=0.31 W/m2K - steel sandwich panel 100 mm

WE_HV_01_S:
heavy façade - U=0.59 W/m2K - prefab concrete  -50 mm exterior insulation - thin PV layer

WE_HV_01_M: 
heavy façade - U=0.44 W/m2K - prefab concrete  -70 mm exterior insulation - thin PV layer

WE_HV_01_L: 
heavy façade - U=0.31 W/m2K - prefab concrete  -100 mm exterior insulation - thin PV layer

WE_HV_02_S: 
heavy façade - U=0.37 W/m2K - insulated concrete sandwich panel - 35 mm internal  insul 

WE_HV_02_M: 
heavy façade - U=0.31 W/m2K - insulated concrete sandwich panel - 50 mm internal insul.

WE_HV_02_L: 
heavy façade - U=0.24 W/m2K - insulated concrete sandwich panel - 70 mm internal insul

WP_LT_01  : 
light party wall - U=0.67 W/m2K - double insulation and double gypsum-fibre board

WP_HV_01  : 
heavy spine wall - U=1.85 W/m2K - prefab concrete - double plasterboard. 

WI_LT_01  : 
light partition wall - U=2.36 W/m2K - un-insulated steel structure - single gypsum-fibre board

WI_LT_02  : 
light partition wall - U=1.00 W/m2K - insulated steel structure - single plasterboard

WI_LT_03  : 
light partition wall - U=0.60 W/m2K - insulated steel structure - double plasterboard

DOOR_EX_WD: 
door - U=2.60 W/m2K - massive wood 

DOOR_EX_MT: 
door - U=0.70 W/m2K - insulated metal panel 

DOOR_IN_PW: 
door - U=1.06 W/m2K - insulated plywood

CE_LT_01  : 
light floor - U=0.21 W/m2K - Insulated steel structure - wooden floor panel

CE_HV_01  : 
Heavy floor - U=2.55 W/m2K - prefab hollowcore concrete 25 cm

CE_HV_02  :
Heavy floor - U=2.65 W/m2K - prefab hollowcore concrete 20 cm

FG_LT_01  : 
light ground floor - U=0.22 W/m2K - insulated steel structure - wooden floor panel

FG_HV_01  : 
Heavy ground floor - U=1.94 W/m2K - concrete - gravel

RO_LT_01_M: 
light roof - U=0.25 W/m2K - steel structure with mineral wool

RO_LT_01_L: 
light roof - U=0.14 W/m2K - steel structure with mineral wool

RO_HV_01_S: 
Heavy roof - U=0.59 W/m2K - hollowcore concrete slab - 40 mm exterior insulation

RO_HV_01_M: 
Heavy roof - U=0.39 W/m2K - hollowcore concrete slab - 70 mm exterior insulation

RO_HV_01_L: 
Heavy roof - U=0.29 W/m2K - hollowcore concrete slab -100 mm exterior insulation

RO_HV_02  : 
Heavy roof - U=0.50 W/m2K - watertank roof

RO_HV_03  : 
Heavy roof - U=0.48 W/m2K - garden roof
4.1.2 Boundary wall

Besides choosing a wall-type, the wall can be defined as a “boundary wall”, which means the space at the other side of the wall is either a space with a known fixed temperature or a zone that is the same as the zone you are planning to simulate. (This can be very useful when you want to simulate a row of similar office-rooms for example).

 In case the space at the other side of the wall has a (more or less) fixed temperature, you have to specify this temperature in the “adjacent temperature” box (see figure at the right). 
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In case at the other side of the wall is a similar zone, you have to select the box “identical”. 

4.2 Window materials

BIOTOOL has at its disposal a number of predefined window types, which can be assigned to a window. An opened window (no glass) is one of the options to choose. The all window-options are shown:

CODE           Description
composition      U-Value
g-value   
T-sol   
Rf-sol   
T-vis   

OPEN
     No_Glass=open



SINGLE       SINGLE, 4mm,k=5.8,g=0.87       
4              
 5.7     
0.871    
0.850    
0.070   
0.900

DOUBLE_1 Double_glass,k=4.3,g=0.78        4/6/4             
4.3     
0.777    
0.726    
0.121   
0.815

DOUBLE_2 Double_glass,k=2.7,g=0.78        
2.5/12.7/2.5   
2.7     
0.777    
0.727    
0.129   
0.817

DOUBLE_3 Double_glass,k=2.8,g=0.76        
4/16/4             
2.8     
0.755    
0.693    
0.126   
0.817  

HPG_2_01  2-Heat_Prot_G,k=3.8,g=0.49       6/6/6            
3.8     
0.493    
0.375    
0.071   
0.473

HPG_2_02  2-Heat_Prot_G,k=1.7,g=0.60     
3.0/12.7/2.5     
1.7     
0.597    
0.544    
0.220  
0.769

HPG_2_03  2-Heat_Prot_G,Argon, k=1.5,g=0.60 5 1.5     
0.596    
0.544    
0.220   
0.769   

HPG_2_04  2-Heat_Prot_G,Argon,k=1.4,g=0.59 4/16/4         
1.4    
0.589    
0.426    
0.266   
0.706 

HPG_2_05  2-Heat_Prot_G,Argon,k=1.3,g=0.59     4/16/4     
1.3     
0.591    
0.426    
0.266   
0.706 

HPG_2_06  2-Heat_Prot_G,crypton,k=1.1,g=0.60  4/16/4     
1.1     
0.598    
0.426    
0.266   
0.706 

SPG_2_01  2-Sun_Prot_G,k=3.7,g=0.24        6/6/6             
3.7     
0.235   
0.127    
0.222   
0.181

SPG_2_02  2-Sun_Prot_G,gold,k=1.3,g=0.21 6/16/6            
1.3
0.212    
0.138    
0.120   
0.238

SPG_2_03  2-Sun_Prot_G,nature,k=1.3,g=0.33 6/16/6         
1.3
0.333    
0.260    
0.218   
0.659

TRIPLE 
    Triple_Pane,k=1.8,g=0.7  2.5/12.7/2.5/12.7/2.5    
1.8     
0.700    
0.624    
0.168   
0.744

HPG_3_01 3-Heat_Prot_G,Krypton,k=0.7,g=0.414/8/4/8/4   
0.7     
0.407    
0.268    
0.231   
0.625

HPG_3_013-Heat_Prot_G,Xenon,k=0.4,g=0.41 4/8/4/8/4      
0.4
0.408    
0.268    
0.231   
0.625
4.2.1 Explanation of the physical properties

U-value [W/m2K] 
= 
heat flow through 1m2 of window at 1K temperature difference between both sides.

g-value
=
solar factor giving the portion of solar heat coming into the zone. (Both direct radiation and heath flow from the windowpanes, as far as this is caused by absorption of solar radiation)

T-sol
=
factor giving the portion of solar radiation that is transmitted into the zone.

Rf-sol
=
factor giving the portion of solar radiation that is reflected by the windowpanes.

T-vis
=
factor giving the portion of visible solar radiation transmitted through the window.

4.3 Occupancy gains

Occupancy gains refer to heat and humidity production inside a thermal zone. Different sources, namely humans, computers and lighting, can cause this production. The heat can be emitted as radiative heat or convective heat or, as in most cases, as a combination of these two, the contribution of each depending on the source.   

4.3.1 Types and schedules

Internal gains need to be described with two parameters: 

· Gain type: referring to the source(s) and amount and type of heat emitted

· Gain schedule: referring to the time at which this heat is emitted. In offices for example, there is only heat emitted during office hours.

In BIOTOOL several predefined types and schedules are available. In the table below the available types and their characteristics are shown. The last column shows the schedule that is per default attached to this type.

The ventilation rate is not used in this version of BIOTOOL, since it is calculated independently.

Name       
= Name of use type                                         
[string]

* Pdensity   
= number of persons / m^2                               
[1/m^2]

* PERS_ISO   
= Index to occupant heat gain rate table,

* VENTrate    
= Ventilation rate                                          
[m^3/person/hour]

* LIGHT       
= Index to lighting heat gain                               
[-]

* Power       
= Lighting Power per square meter                     [W/m^2]

* OCCschedule = Name of use schedule                                      [string]          

*

* Name,              Pdensity,    
ISO
VENTrate,
LIGHT,
Power, 
CCschedule

  Atrium,             
0.322917313,    
05,       25.48516193, 
03,    
13,    
Office

  Classroom,      
0.538195521,    
02,       25.48516193, 
04,    
17,    
School

  Conference,
0.538195521,    
02,   
98021591, 
04,    
17,    
Office

  Corridor,
0.035843822,    
05,       25.48516193, 
02,    
10,    
Office

  Dining Area, 
0.753473729,    
03,       33.98021591, 
04,    
17,    
Restaurant

  Exhibit Space, 
1.076391042,    
05,       25.48516193, 
04,    
17,    
Museum

  Gym,
0.322917313,    
11,       33.98021591, 
05,    
19,    
School

  Kitchen,   
0.215278208,    
06,       25.48516193, 
05,    
19,    
Restaurant

  Laboratory,        
0.322917313,    
05,       33.98021591, 
04,    
17,    
Office

  Lobby,              
0.322917313,    
05,       33.98021591, 
04,    
17,    
Office

  Locker Room,   
0.358438217,    
04,       25.48516193, 
02,    
10,    
School

  Manufacturing, 
0.107639104,    
07,       25.48516193, 
05,    
19,    
Manufacturing

  Mechanical/Electrical Rooms, 0.035843822, 05,  25.48516193, 
03,    
13,    
Office

  Office - Enclosed, 0.075347373,   
02,       
33.98021591, 
04,    
17,    
Office

  Office - Open,  
0.075347373,    
02,       
33.98021591, 
03,    
13,    
Office

  Religious Worship Space, 1.614586563, 02, 25.48516193, 
06,    
55,    
Religious

  Residential, 
0.021527821,    
04,       
25.48516193, 
03,    
13,    
Residential

  Retail Sales Area, 0.322917313,    
05,       
16.99010796, 
05,    
19,    
Retail

  Stairs,        
0.035843822,    
07,       
25.48516193, 
02,    
10,    
Office

  Storage - Active,
0.053819552,    
05,       
25.48516193, 
03,    
13,    
Office

  Storage - Innactive, 0.01076391, 
05,       
16.99010796, 
01,     
5,    
Office

  Toilet,         
0.161458656,    
04,       
67.96043182, 
03,    
13,    
Office
The available schedules:

· None

· Manufacturing

· Museum

· Office

· Religious

· Restaurant

· Retail

· School

4.3.2 Dialog box

Predefined internal gain types (as seen previously) and schedules must be chosen for each independent zone in the “thermal zone properties” dialog box, which is shown in the figure below. 
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4.4 Heating and cooling 

4.4.1 Dialog boxes

Most of the information must be entered in the “thermal zone specification” dialog box; only the period in which heating is turned OFF and the period in which the cooling is turned ON must be specified in the ”global settings” dialog box. Relevant parts of both boxes are shown in the figures below.

4.4.2 HEATING

For each zone, in the “Thermal zone specification” dialog box, the heating type should be defined. The first version of BIOTOOL offers three possibilities:

1. NO HEATING. 

2. CONSTANT SCHEDULE. We only need to define the set point temperature for the heating to turn on.  

3. WITH SETBACK SCHEDULE. We need to define in the dialog box the following values:

· Set point temperature 

· Set back temperature 

· Hour when set point temperature starts 

· Hour when set point temperature finishes
	[image: image116.png]



	


In the “global settings” dialog box the period when HEATING is off (summer period) must be defined. Defined by two variables “Stop hour” and “Start hour”. 

4.4.3 COOLING

For each zone, in the “Zone” dialog box, the cooling type should be defined. The 1st BIOTOOL version has three possibilities:

	
	


1. NO COOLING. 

2. CONSTANT SCHEDULE. We need only to define the set point temperature.

3. WITH SET UP SCHEDULE. We need to define in the dialog box the following values:

· Set point temperature 

· Set up temperature 

· Hour when set point temperature starts 

· Hour when set point temperature finishes 

In the “Global Settings” dialog box the period when COOLING is on (summer period) must be defined. Defined by two variables “Stop hour” and “Start hour”.

4.5 Infiltration 

For each zone adjacent to exterior the infiltration through closed constructions must be defined. The infiltration value is given in ACH (air change rate) in [l/h]. This value depends mainly on the wind velocity and the air-tightness of the construction. 

4.5.1 Infiltration types

In BIOTOOL the user can choose between no infiltration and three predefined infiltration types:

· No infiltration

· High Air-tightness (ACH = 0.5)
· Medium Air-tightness (ACH = 0.6)
· Poor Air-tightness (ACH = 0.9)

These infiltration types defined assume the following building characteristics:

· Collective buildings (no individual houses)

· Exposure to wind: Building protected (medium protected)

· Multiple exposition (the building has more than one exterior wall)

Reference: EN-832, Thermal performance of buildings. Calculations of energy use for heating. Residential buildings. 

The ACH is the same during the whole period of the simulation, but can differ for different zones.

4.5.2 Dialog box for infiltration

For each thermal zone, the infiltration type must be defined. This can be done in the lowest parameter of the dialog box called “thermal zone specification”. 
In the following figure the dialog box is shown; the drop-up menu allows the above-mentioned infiltration types. 
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4.6 Ventilation

4.6.1 Ventilation possibilities

In BIOTOOL, the following airflows can be simulated:

· Airflow between a zone and the exterior 

· Airflow between zones. 

This way all-possible ventilation strategies can be simulated, like interzonal air-change, cross ventilation and a ventilation circle between more than two zones.  

Airflow can occur through 3 different elements:

· An external opened window (includes external opening and external opened door)

· A mechanical ventilation device

· An adjacent opening (between two zones)

For each element the velocity of the airflow has to be defined and the direction of the airflow (inflow or outflow).

Nomenclature for definition of airflows:

A = Area

W = velocity in windows

M = velocity in mechanical devices

O = velocity in openings

in = inflow

on = outflow

Once all airflows are defined, a mass in balance checks needs to be done to secure that for each zone the inflow and outflow are equal. 

The ventilation occurring at windows, openings and mechanical devices must be entered in BIOTOOL in the corresponding dialog boxes.

4.6.2 Opened window 

Opened windows are introduced in the window dialog box, choosing the option “no_glass”.


4.6.3 Adjacent openings


To open this dialog box, the user must select step 7 in the wizard and when the materials and conditions window appears, pick the option “adjacent opening” and select an adjacent opening (drawn in GID). The adjacent opening is an opening between two zones (for example, two zones: zone2 and zone4).

The first field contains the name of the first zone. It cannot be modified. The second field contains the names of the second zone. It cannot be modified. The airflow between the two zones can be defined by pushing the “reverse” button if required. When this dialog box is closed, GID will assign variables to: 

· The 2 adjacent zones selected

· Zone inflow

· Zone outflow

· Each surface of the opening

· Flow direction 

· Flow velocity

4.6.4 Mass Imbalance check

Once Conditions are defined for each type of airflow (window, opening or mechanical device), the user has to assure the mass imbalance is 0 (to assure the total inflow in a room is equal to the total outflow), before calculating. This can easily be done because the BIOTOOL automatically makes a mass-imbalance check, which can be seen in step 9 of the FATHERM wizard. The explanation to use the mass imbalance option is shown in chapter 3.5 of part 2.

4.7 Default values

4.7.1 Settings

The default settings applied for the typologies depending on location and function of the zones are shown below.  

	
	Typologies NORTH
	Typologies SOUTH

	
	All zones within a dwelling
	Shared staircases
	All zones within a dwelling
	Shared staircases

	Occupancy      Type & Schedule
	- residential occ.  type

- residential schedule 
	- none
	- residential occ. type

- residential schedule 
	- none

	Heating
	- constant 20 ºC*
	- none
	- constant 20 ºC*
	- none

	Cooling
	- constant 25 ºC*
	- none
	- constant 25 ºC*
	- none

	Heating off / Cooling on period
	June 1st – Sept 1st      hour: 3624 – 5832
	 (not applicable)
	May 1st – Oct 1s hour: 2880 – 6552
	 (not applicable)

	Infiltration


	High airtighness
	Medium. airtightness
	 Medium airtightness
	Medium airtightness



	Ventilation strategy
	No ventilation

No mechanical devices

	Shading devices
	Not  possible yet

	Settings
	Start time:0, stop time: 8760, time step: 1 hour


*(according to ASHRAE and CTE2000)
4.7.2 Materials

The default materials applied for the typologies depending on location and construction material are mentioned below:

	
	Typologies NORTH
	Typologies SOUTH

	
	Concrete (HV_N)
	Steel (LT_N)
	Concrete (HV_S)
	Steel (LT_S)

	Façade
	WE_HV_02_L
	WE_LT_01_M
	WE_HV_02_S
	WE_LT_01_S

	Party wall 
	WP_HV_01
	WP_LT_01
	WP_HV_01
	WP_LT_01

	Interior wall
	WI_LT_02

	Interior door
	DOOR_IN_PW

	Exterior door
	DOOR_EX_WD

	Ground floor 
	FG_HV_01
	FG_LT_01
	FG_HV_01
	FG_LT_01

	Ceiling / Floor
	CE_HV_01
	CE_LT_01
	CE_HV_01
	CE_LT_01

	Roof
	RO_HV_01_L
	RO_LT_01_L
	RO_HV_01_S
	RO_LT_01_M

	Window
	HPG_2_02
	DOUBLE_1


5 ANNEXES

5.1 GiD Manual

GiD is the interactive graphical interface for the BIOTOOL.

GiD is an interactive graphical user interface used for the definition, preparation and visualization of all the data related to a numerical simulation. These data include the definition of the geometry, materials, conditions and other parameters. 

After having introduced all necessary data, BIOTOOL-GiD writes the information for a numerical simulation program in its desired format. It is also possible to run the numerical simulation from within GiD and to visualize the results of the analysis. 

5.1.1 GiD layer tree

GiD has ordered all the geometrical elements from the drawing of the building in a layer tree. The first division of the layers is according to the storey. Within each storey, there are six layers, which are listed in the table below. In the right column of the table the real elements that are placed in this layer are mentioned. With help of this layer tree it is possible to show or hide elements.

	Layer
	Real Elements

	Door 
	· Closed (opaque) door*

	Opening
	· Adjacent opening (= opening between rooms, also includes opened doors)

	Room
	· Zones / rooms, 

· floors, roofs

	Wall
	· Walls

	Window
	· Closed exterior windows

· Opened exterior windows (= also: external opening or external opened door)

	Mechanical device
	· Mechanical device


*Doors are considered completed opaque elements. If a door is transparent (it has certain percentage of glazing), it is considered as a window.

In the table below an overview is given of the GiD elements and their corresponding real building elements, corresponding layers and corresponding dialog boxes:

	GiD element


	Real element
	Layer


	Properties from

Dialog box: 

	Wall
	Wall
	Wall 
	Wall selection

	Door
	Adjacent door closed
	Door
	

	
	External door closed*
	
	

	Floor
	Floor
	Room

Room
	

	Roof
	Roof
	
	

	Window*
	External Window closed
	Window

Window
	Window selection

Window selection

	
	External window opened
	
	

	
	External door opened 
	
	

	
	External opening
	
	

	Zone
	One or more rooms
	Room
	Zone properties

	Mech. device
	Mechanical ventilation device
	Mech. device
	Mechanical device

	Adjacent Opening
	Adjacent window opened
	Opening
	Adjacent opening.

	
	Adjacent door opened
	
	

	
	Adjacent Opening
	
	


* Adjacent closed windows are not implemented in the first version of BIOTOOL.

Within each element one or more properties have to be specified:

5.1.2 The user basics

The user basic applications that are shown in the Standard tool bar are explained below.

5.1.3 Files

GiD includes the usual ways of saving and reading saved information (Save, Read) and other file capabilities, such as importing external files, saving in other formats and so on. 


New file 

New opens a new project with no title assigned. 

If this option is chosen while another project where some changes have been introduced is still opened, GiD asks to save them before opening the new project. Next, a new problem without a title begins. 

Open file

With this command, a project previously saved with Save (see section Save) or with SaveASCIIproject (see section ASCII project) can be opened. 

Save

Save a project is the way of saving all the information relative to the project: geometry, conditions, materials, mesh, etc. on the disk. 

To save a project, GiD creates a directory with its name and extension .gid. Some files are written into this directory containing all the information. Some of these files are binary and others are ASCII. The user can then work with this project directory as if it were a file. 

User doesn't need to write the .gid extension because it will be automatically added to the directory name. 

Caution: Be careful with changing some files in the Project.gid directory manually. If done in this way some information may be corrupted. 

Advice: It is advisable to save often to prevent losing information. It is possible to automatically save a model backup by selecting a user frequency (see section Preferences). 

Save as

With this command, GiD allows the user to save the current project with another name. When it is selected, an auxiliary window appears with all the existing projects and directories to facilitate the introduction of the project's new name and directory. 

Import

With this option it is only possible to read / import a file in DXF format, version AutoCAD 2002. Import options for other file types are not activated. Almost all the geometry in the DXF is read except the solid modelled entities.  Importing these entities is, in the case of BIOCELLI , not useful, since the import option exists in the Wizard menu (see section 4 import dfx files) that is better / easier to use.

A very important parameter to consider is related to how the points must be joined when importing a drawing. This means that points that are close to each other must be converted to a single point. This is done by defining a range of tolerance; different point at this (or smaller) distance will be considered to be a single point. Straight lines that share both points are also converted to a single line. 

VIEW FUNCTIONS:

Following all view options are explained. To leave any of these functions, press “escape”. (or tell this at the end of every description.)
Zoom

Zoom is used to change the visualized size of the objects without deforming them. This only enlarges or reduces the objects and changes the orthogonal perspective of the window. 

· Zoom window & Zoom in: 
[image: image29.png]


 
 Pick inside the graphical window. A dynamic rectangle is opened. Pick again and the visualization changes to display only the part within the defined rectangle. 

· Zoom dynamic: 
[image: image30.png]


 Moving mouse horizontally, view-size is enlarged or  reduced. 

· Zoom frame: 
[image: image31.png]


 Choose a visualization size so as to display everything inside the window. 

· Zoom out: 
[image: image32.png]


 Pick inside the graphical window. A dynamic rectangle is opened. Pick again and the visualization changes so that everything in the graphical window is reduced to the size of the rectangle 

· Zoom previous: 
[image: image33.png]


 GiD goes to the previous saved zoom. 

Pan dynamic


[image: image34.png]


 With this command, the location of the geometry can be displaced in the graphical window. 
The displacement is made dynamically, by moving the mouse over the screen while pressing the left mouse button. 
Trackball


[image: image35.png]


 With this option, a dynamic rotation is made, resembling a trackball device. It means that when picking a geometry point with the left mouse and moving the mouse, the geometric point tries to follow the mouse pointer. This can be imagined as a ball over the graphical window, which is moved with the mouse. 

The left mouse button can be pressed several times to connect and disconnect the movement. To leave this function, use escape (see section Escape). 

Top view, Bottom view, Left view, Right view, Front view, Back view
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By using this options, the direction from which the model is shown changes. There are six options: Top, Bottom, Left, Right, Front and Back view, from which the user can choose. 

Render 


[image: image42.png]
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By using this option, the way of viewing the model changes. There are two options: 

· Normal: This is the usual way of visualizing. The geometry and mesh are viewed including all definition lines. 
· Flat lighting: Solid model with flat illumination and lines. 

All available geometrical operations, generating or deleting entities and performing particular options are included in this chapter. All geometrical operations allow the activation of the contextual menu, which is explained previously, by clicking the right mouse button.

Draw line 


[image: image44.png]


 To create several straight lines it is only necessary to pick one point and continue entering points in order to create more lines from the first one. Every part of the total line created is an independent line. To leave this function, use escape (see section Escape). 

It is important to note that when creating lines, new points are also being created (if not using existing ones). 

[image: image45.wmf]
Option Close joins the last point with the first point created with a straight line and finishes the process.

5.2 Favent Manual 
This document is Favent user’s manual. The bulk of this document is devoted to explain the data that has to be introduced in order to run a CFD simulation with Favent. Technical aspects of the implementation as well as numerical techniques behind them are just overviewed. A certain theoretical background is, in consequence, assumed. The user is referred to the bibliography and to the citations appearing therein for major explanations of these subjects. The manual is structured in four main sections:

· Section 2. Introduction to the types of physical problems that can be solved and few comments on the numerical strategy.

· Section 3. Description the graphical environment of Favent package.

· Section 4. Guide for the solution of CFD problems with Favent. 

· Section 5. Some examples.

Please, send any comments or suggestions to houzeaux@cimne.upc.es.

5.2.1 What is Favent?

Favent is a user-friendly package for performing the numerical simulation of thermally coupled flow problems. Its main objective is to permit the numerical study of natural ventilation in/and around buildings, although its general characteristics enable the solution of more problems. Favent package is composed of three main modules, as show in the following diagram: 


The three modules are:

· GiD is a graphical interface for the pre and post-process of the package. It includes:

· CAD tools to create the geometry.

· A mesh generator to divide the computational domain into finite elements.

· A personalized module (called problem type) to manipulate your own data, create your own windows and menus.

· A post-process module to visualize the results of a simulation.

· Problem type Favent enables the edition of the boundary conditions and data of the CFD simulation, as well as to launch the CFD simulation. When loading Favent problem type, a new menu named Favent is created in the menu bar of GiD. This menu gives access to the specific function of the CFD simulation.

· FaventCFD code performs the finite element simulation. Its main features from the point of view of the simulations it can perform include:

· Laminar flows. Navier-Stokes equations.

· Turbulent flows. RANS equations together with Spalart-Allmaras model. 

· Thermally coupled flows. The heat equation may be solved together with the incompressible Navier-Stokes equations and, in particular, flows driven by temperature gradients can be dealt with.

5.2.2 FaventCFD code

Physical Problems

This section overviews the governing equations of the problems that can be solved by this version of FaventCFD. These are the classical Navier-Stokes (NS) or Reynolds-averaged Navier-Stokes equations (RANS) and heat transmission equations derived from general principles of mass, momentum and energy conservation.

Reynolds-averaged Navier-Stokes (RANS) Equations

The equations describing the problem are those of a turbulent incompressible Newtonian fluid:
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to be solved in ( ( (0,tfin), where ( ( Rn (n = 2 or 3 being the space dimension) is the computational domain and (0,tfin) is the time interval to be considered. In the equations above, u denotes the velocity field, p is the pressure,   is the viscosity, t  is the turbulent viscosity, (  is the velocity symmetrical gradient tensor 
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and f is the vector of body forces per unit of mass. In the above equations, constant density and the Boussinesq assumption for the Reynolds stress tensor of turbulent flows have been assumed. 

The force vector f contains gravity acceleration and the buoyancy terms coming from the Boussinesq assumption, that is:
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where g is gravity acceleration, (  is the thermal expansion coefficient, T is temperature, T0 is the reference temperature from which buoyancy forces are computed.

NOTE: When t = 0 the equations that describe the laminar regime are recovered. The eddy viscosity is defined as t=t/.

Navier-Stokes equations must be solved together with a given set of boundary and initial conditions. Consider the boundary ( split into three sets of disjoint components as ( = (D ( (N ( (M, where (D, (N and (M are, respectively, the parts of the boundary with Dirichlet, Neumann and mixed boundary conditions for the velocity. If the Cauchy stress tensor is written as:
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and the prescribed values are represented by an over-bar, the boundary conditions to be considered are:
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for t ( (0,tfin) and where g is the tangent vector to the boundary and n the exterior normal. To close the problem, initial conditions have to be appended. It implies that an initial velocity field must be proportioned.

Heat Equation

The equation describing the thermal problem is:
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where Cp is the specific heat at constant pressure (i.e. ( Cp is the heat capacity), k is the thermal conduction coefficient, and kt is the turbulent thermal conduction coefficient. The Fourier’s law for heat diffusion is assumed. The Joule effect is neglected. The turbulent thermal conduction coefficient is approximated by
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where Prt is an dimensionless parameter called the turbulent Prandtl number (which varies between 0.9 and 1.0 for air).

The heat equation must be solved together with a given set of boundary and initial conditions. Consider the boundary ( split into two sets of disjoint components as ( = (D ( (N , where (D and (N are, respectively, the parts of the boundary with Dirichlet and Neumann boundary conditions for the temperature. If prescribed values are represented by an over-bar, the boundary conditions to be considered are:
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for t ( (0,tfin). To close the problem, initial conditions on temperature have to be appended.

NOTE: When kt = 0 the heat equation for the laminar regime is recovered. 

Turbulence models

In this version of Favent, only the Boussinesq assumption for the Reynolds stress tensor is contemplated (algebraic stress models are not included). It implies that the turbulent models only need an expression for the turbulent viscosity. While the two-equation k-  turbulence model is extensively used in the simulation of ventilation problems (see e.g. [Chen95, XuChen01]), a more simple one-equation turbulence model, namely the Spalart-Allmaras model, was preferred for several reasons: it involves only one additional differential equation; it is computationally robust; in many situations (forced convection) it gives similar results to two-equation turbulence models.

Spalart-Allmaras turbulence model consists of a single partial differential equation which solves directly for the eddy viscosity:
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where Cw1, , Cb1 and Cb2 are constants of the model, fw is a function of the vorticity and d is the distance to the wall. The version displayed here is to be used for high-Reynolds number flows. A low-Reynolds number version, which includes addition terms, is also available. It is not shown here for the sake of clarity.

Wall boundary conditions

The turbulence model presented before is a high-Reynolds number model, and therefore can not be integrated up to the wall.  However, it includes viscous effects (not displayed here) that enable the solution of the flow equations up to the wall. We divide this section into two so that low and high Reynolds-number flows are treated separately.

Low Reynolds number flows

When the turbulence model includes viscous corrections to be integrated up to the wall, one can impose the real physical boundary conditions on the wall. These are the no-slip condition for the RANS equations (u=0), the prescribed wall temperature Tw for the heat equation, and zero eddy viscosity for the turbulence model, i.e. t=0.

High Reynolds number flows 

Although the Spalart-Allmaras turbulence model takes into account near-wall (viscous) effects, the RANS equations are rarely integrated up to the wall.  In fact, the only way to solve the sharp gradients in play in the boundary layer would be to capture them with a very fine mesh, a solution which can be prohibitive for high Reynolds number flows. The idea is to make some approximations in the boundary layer and not to solve the governing equations all the way down to the wall. The solution strategy here is to apply the law of the wall.

Wall laws are based on the extrapolation of analytical results obtained using simple idealized geometries. Let us define the friction velocity called U* which is related to the wall shear stress w as w=U*2. Let us consider a point located at a distance y from the wall and define its dimensionless distance to the wall y+ as well as its dimensionless velocity u+ as:


[image: image55.wmf]*

*

 

  

=

yU

y

u

U

n

+

+

=

u


The law of the wall assumes that we know a relation between u+ and y+ of the form:
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The equation used here is the Reichard’s law which is given by
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where (=0.41 is the Von Kármán constant. It is valid throughout the viscous, the buffer and the turbulent zones of the boundary layer. By substituting the expression for y+ as a function of U*, we obtain a non-linear equation for the friction velocity U*. From the value of the friction velocity, se wet up the boundary conditions for the flow variables. In order to impose these boundary conditions, we assume that our computational domain is located at a distance y away from the wall and apply the Reichard’s equation.





The distance to the wall y is a user-defined parameter. Although the law of the wall is “valid” throughout the boundary layer, we must make sure that it is applied in the range y+=[40,80]. If y+ were to fall under 40, then we may not be able to capture the high gradients of the boundary layer. The distance to the wall must therefore be defined such that as an averaged along the wall,
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Unfortunately, this can only be checked a posteriori, after the simulation is performed. Nevertheless, y can be estimated so that this criteria is likely to be satisfied.

RANS equations

Assuming that the shear stress is constant across the boundary layer, we have that the tangential component of the traction on the wall is given by:
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so that the boundary condition on walls for the velocity is
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Heat equation 

For the heat equation, a law of the wall is also prescribed. The temperature on the boundary is calculated iteratively as a function of the wall temperature Tw and the wall heat flux qw as:
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where T+ is given by
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and where Pr is the Prandtl number of the fluid such that
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Spalart-Allmaras equation

For the turbulent viscosity, the mixing length hypothesis together with Van-Driest damping is assumed. This implies that we have at the wall
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where du+/dy+ is obtained by deriving Reichard’s law.

5.2.3 Numerical Treatmet

This section overviews some features concerning the numerical treatment implemented in this version of Favent. 

Time Discretization

Let 0 = t0 < t1 < ... < tn = tfin be a partition of the time interval and consider, for simplicity, a time step size (t = tn+1- tn constant for all n. Consider also the following notation:
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where f  is a generic function of time (f n denotes the value of f at time tn or an approximation to it), and ( is a vector of three components ((1, (2, (3). Time discretizations for the Navier-Stokes and heat equations contemplated by Favent are given in what follows. 

RANS equations

Monolithic schemes solve simultaneously for all the unknowns (velocity components and pressure). The time discretization for the monolithic scheme is:
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where ( controls the time discretization of all the terms. 

· First order scheme. Characterized by ( = (1.0, 0.0, 0.0), that is, the backward Euler scheme.

· Second order scheme. Characterized by ( = (0.5, 0.5, 0.0), that is, the Crank-Nicholson scheme.

Both possibilities are unconditionally stable, although the former is expected to be second order accurate whereas only a first order approximation can be expected for the latter. Both options are available. 

Heat equation

Heat equation is time discretized as follows:
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where ( controls the discretization of all the terms. 

· First order scheme. Characterized by ( = (1.0, 0.0, 0.0), that is, the backward Euler scheme.

· Second order scheme. Characterized by ( = (0.5, 0.5, 0.0), that is, the Crank-Nicholson scheme.

Both possibilities are unconditionally stable, although the former is expected to be second order accurate whereas only a first order approximation can be expected for the latter.

Spalart-Allmaras equation

We use the same strategy as that of the heat equation. 

Time step size

Two criteria can be used to compute the time step size. One is based on the physical behavior of the problem, and the other is based on stability analysis. In the former case, the time step can be provided by the user or can be guessed by the program from some velocity and length scales (U and L respectively) computed internally, such that t=L/U. In the latter case,  which may be chosen when no a-priori physical information on the time scale is available, the time step is computed internally by the program using the following strategy. 

Stability analysis in finite differences shows that any explicit scheme is conditionally stable, that is, there exists a maximum time step able to ensure stability. This time step is known as the critical time step. Usually, an extension of the 1D convection-reaction-diffusion (CDR) equation is considered to compute the critical time step of the Navier-Stokes and temperature equations, that is, the terms in these equations are identified with analogous terms of the 1D CDR equation. In transient problems, FaventCFD computes the time step size of each problem as the critical one multiplied by a safety factor that can be externally fixed.

The implicit schemes used in FaventCFD are unconditionally stable and, in consequence, admit safety factors much greater than 1 (time step sizes much greater than the critical one). However, in non linear problems, time step sizes can not be arbitrarily large in order to guarantee convergence.

NOTE: In thermally coupled flow problems, the time step size used by FaventCFD is the minimum between the Navier-Stokes equations time step size and the temperature equation time step size.

Weak Form and Boundary Conditions

Once the time discretization has been carried out, the problems are discretized in space using a finite element method. FaventCFD uses linear interpolation for all variables, that is equal order interpolation for velocity and pressure.  

The diffusion terms of all the equations are integrated by parts so that the Neumann conditions coincide with the natural conditions of the weak forms.

Linearization of the Variational Problem

The variational problems associated with the Navier-Stokes equations may present, in general, several sources of non-linearity that must be faced before obtaining the finite element approximation to it. The first source of non-linearity comes from the convective term of the Navier-Stokes equations. Here, the fixed point Picard scheme is used. 

The convective term of the heat equation can couple the Navier-Stokes equations with the heat equation in non-linear way. Obviously this will occur only for thermally coupled flow problems. The strategy of FaventCFD to face coupling between different physical problems is to use an iterative coupling by means of the coupling loop. The idea is to use the temperature known from the previous iteration in the momentum equation, and then use this equation to compute the velocity and the pressure. With the velocity computed, one can proceed to solve the heat transport equation. See section Basic algorithm.

Finite Element Approximation and Stabilization

Once the variational problems have been established, the final step is to undertake the finite element approximations to them. It is also necessary to use any stabilization method capable of dealing with all the instabilities that the standard Galerkin method presents. For the particular case of the Navier-Stokes equations it includes the pressure instability and the instability arising in convection-dominated situations. Temperature equation requires also a stabilization method in convection dominated problems. The stabilization technique used in this code is the Subgrid Scale model (SGS) of [Cod98] and originally proposed in [Hug95].

Discontinuity Capturing

In some cases, the solution of either the RANS, the turbulence or the heat equations may exhibit sharp gradients which may lead to localized oscillations. In order to remove them, FaventCFD contains a discontinuity capturing (also known as shock capturing) technique. 

5.2.4 Basic Algorithm

The kernel of FaventCFD consists of two different nested loops designed to solve any kind of coupled problem. The main structure is shown in the figure below:




The two loops of this algorithm are:

· Time loop. It is a loop over time steps. 

· Coupling loop. This loop solves all the problems involved for each time step. It allows an iterative solution to handle coupling between different types of problems. Each specific problem (Navier-Stokes, turbulence, heat) could have its own internal loop to solve non-linearities. This version solves only once each equations.

The convergence of this algorithm is controlled  by the “L2 residual norm” of the flow variables, u, p and T. It is itself is a measure of the change of a variable from one iteration to another. For a variable f, we define the L2 residual norm i of f at iteration i as:
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where fi(n) is the value of f at node n and iteration i.

5.2.5 Favent package environment

As mentioned at the beginning of this manual, Favent package contains a graphical interface named GiD, within which the whole process of a CFD simulation is embedded. The main window of GiD is shown in the next figure.
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As a pre-process, GiD includes CAD tools to draw the computational domain. See the specific options in GiD online help (menu Help -> Help). From now on, we assume the reader knows how to create a geometry. Note finally that the dimensions have to be given in meters.

To access Favent environment, you must load the problem type Favent. The Favent problem type is a directory located in the problemtypes/ directory of GiD, as shown in the following figure.


To load Favent problem type, select the option Data -> Problem Type -> Favent. As several versions of Favent can coexist, the version number is put as a suffix in the problem type name. For example, problem type Favent10 corresponds to the version 1.0 of Favent.
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In the menu bar, an additional menu named Favent appears. This menu contains all the specific options of Favent package.

 See the online manual of GiD or GiD web page for any additional information on GiD: http://gid.cimne.upc.es/.

Theses options are only shortcuts to functions already existing in GiD. They will now be described one by one.

5.3 Open project 

The first option is not to be used if you are working on a new geometry. Remember that the dimensions must be given in meters. Project are to be saved in the Examples directory of GiD. Next figure shows the directories containing some examples.

5.3.1 Examples

We now solve two simple examples to illustrate the complete strategy of a CFD simulation. We first open GiD.

Backward facing step

We solve a simple backward facing. The backward facing step can be thought as a 2D section of a room, where a recirculating flow develops behind a corner. The geometry is shown in the following figure. The inflow velocity is U=1.06 m/s. 

The Reynolds number based on h and U is approximately 7x104. This problem is solved using the wall function approach. Follow the steps:

· Create the geometry as shown in the following figure:
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· Open Favent problem type. Menu Data -> Problem type -> Favent.

· Open Favent Wizard. Menu Favent -> Wizard.

· Open Problem data window. The solution to this problem is a stationary turbulent flow.  Select the following options:
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· As for the numerical data, select a Medium accuracy and a Maximum number of iterations of 50.

· Open the Boundary condition window. 

· For the inflow, open the Mechanical device 2D window, and prescribe an inflow with velocity 1.06 m/s. The condition on temperature is not useful as the heat equation is not solved.

· On the walls, assign a Wall 2D condition.

· Generate the mesh.

· Save the project.

· Press the calculate button. 

· You can visualize the LogFile generated by FaventCFD by selecting the option Favent -> Log file in order to have a global look at your data and boundary conditions.


· Check the convergence of the algorithm by selecting the option Favent -> Plot convergence. The following figure shows that the velocity has achieved a L2 residual norm of 0.1.
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· Check the law of the wall. We observe that y+ varies from 0 to 160.
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· When the calculation is over, you can go to the post-process. For example you can visualize the velocity vectors in the recirculation zone.
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As an exercise, you can try to solve this flow using the Transient-to-Stationary technique in order to obtain a steady state solution.

Natural convection in a tall cavity

The data of the problem are H=2.18 m, W=0.076 m, D=0.52 m, and T1 and T2 are such that T2-T1=19.6 C. The origin of the axes is placed on the bottom wall, at half distance between the front and back wall. The Raleigh number Ra of the problem is

Ra=8.6 x 105. Due to the temperature difference between the left and right hand-side wall, and because hotter air is lighter, the fluid initiate a counter clock wise circulation.

This example is solved by considering only the mid-plane section at z=0. Let us start the simulation process.

· Create the geometry as shown in the following figure:


· Open Favent problem type. Menu Data -> Problem type -> Favent.

· Open Favent Wizard. Menu Favent -> Wizard.

· Open Problem data window. The solution to this problem is a stationary turbulent flow, but we solve it through a transient problem.  Select the following options: 
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· For this very sensible problem, the discontinuity capturing should be turned off.

· In order to follow the temporal evolution of a point, put a witness point near the top of the cavity, as shown in the following figure.
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· Open the Boundary condition window. 

· For the top and bottom wall, impose a Wall 2D condition with adiabatic condition for temperature.

· For the left hand side wall, impose a Wall 2D condition together with a prescribed temperature of 15. Impose a Wall 2D condition on the opposite wall with a prescribed temperature of 34.6 degrees. 

· Generate the mesh.

· Save the project.

· Press the calculate button. 

· You can visualize the LogFile generated by FaventCFD by selecting the option Favent -> Log file in order to have a global look at your data and boundary conditions.

· Check the convergence of the algorithm by selecting the option Favent -> Graphs -> Convergence from the menu.
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· Check the evolution of the velocity of the witness point by selecting the option Favent -> Graphs -> Witness velocity from the menu.
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· You can go to post-process. For example you can visualize the U-turn of the flow in the top of the cavity.
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